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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 

Curiosity LPC Development Board. Items discussed in this chapter include:

� Document Layout

� Conventions Used in this Guide

� Recommended Reading

� The Microchip Website

� Development Systems Customer Change Notification Service

� Customer Support

� Revision History

DOCUMENT LAYOUT

This document describes how to use the Curiosity LPC Development Board as a 

development tool to emulate and debug firmware on a target board. The document is 

organized as follows:

� Chapter 1. �Introduction to Curiosity Low Pin Count (LPC)� � This chapter 

contains general information regarding the Curiosity LPC Development Board kit 

contents, layout and power source.

� Chapter 2. �Getting Started� � This chapter offers information on how to 

program the Curiosity LPC Development Board.

� Chapter 3. �Troubleshooting� � Consult this chapter for troubleshooting 

information.

� Appendix A. �Schematic� � This appendix lists the Curiosity LPC Development 

Board schematic.

� Appendix B. �General Notes� � Refer to this appendix for general notes on 

using the Click module sockets and the solder blob jumpers.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 

documentation are constantly evolving to meet customer needs, so some actual dialogs 

and/or tool descriptions may differ from those in this document. Please refer to our website 

(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a �DS� number. This number is located on the bottom of each 

page, in front of the page number. The numbering convention for the DS number is 

�DSXXXXXA�, where �XXXXX� is the document number and �A� is the revision level of the 

document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 

Select the Help menu, and then Topics to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE 

This manual uses the following documentation conventions:

DOCUMENT CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB IDE User�s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 

dialog

�Save project before build�

Underlined, italic text with 

right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N�Rnnnn A number in verilog format, 

where N is the total number of 

digits, R is the radix and n is a 

digit.

4�b0010, 2�hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, �A�

Italic Courier New A variable argument file.o, where file can be 

any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 

[options]

Curly brackets and pipe 

character: { | }

Choice of mutually exclusive 

arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 

var_name...]

Represents code supplied by 

user

void main (void)

{ ...

}
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RECOMMENDED READING

This user�s guide describes how to use the Curiosity LPC Development Board. For the 

latest information on using other tools, refer to the MPLAB® X IDE home page: 

www.microchip.com/mplab/mplab-x-ide. This resource page contains updated 

documentation, downloads and links to other MPLAB X compatible tools, plug-ins and 

much more.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website 

is used as a means to make files and information easily available to customers. 

Accessible by using your favorite Internet browser, the website contains the following 

information:

� Product Support � Data sheets and errata, application notes, sample programs 

and labs, design resources, user�s guides and hardware support documents, 

latest software releases and archived software

Curiosity Development Board-specific product support can be accessed via our 

website at www.microchip.com/promo/curiosity-development-boards.

� General Technical Support � Frequently Asked Questions (FAQs), technical 

support requests, online discussion groups, Microchip consultant program 

member listing

� Business of Microchip � Product selector and ordering guides, latest Microchip 

press releases, listing of seminars and events, listings of Microchip sales offices, 

distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip�s customer notification service helps keep customers current on Microchip 

products. Subscribers will receive e-mail notification whenever there are changes, 

updates, revisions or errata related to a specified product family or development tool of 

interest.

To register, access the Microchip website at www.microchip.com, click on Customer 

Change Notification and follow the registration instructions.

The Development Systems product group categories are:

� Compilers � The latest information on Microchip C compilers, assemblers, linkers 

and other language tools. These include all MPLAB C compilers; all MPLAB 

assemblers (including MPASM� assembler); all MPLAB linkers (including 

MPLINK� object linker); and all MPLAB librarians (including MPLIB� object 

librarian).

� Emulators � The latest information on Microchip in-circuit emulators.This 

includes the MPLAB REAL ICE� and MPLAB ICE 2000 in-circuit emulators.

� In-Circuit Debuggers � The latest information on the Microchip in-circuit 

debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit� 3 

debug express.

� MPLAB IDE � The latest information on Microchip MPLAB IDE, the Windows® 

Integrated Development Environment for development systems tools. This list is 

focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 

MPLAB SIM simulator, as well as general editing and debugging features.

� Programmers � The latest information on Microchip programmers. These include 

production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 

ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 

are nonproduction development programmers such as PICSTART® Plus and 

PICkit 2 and 3.

http://www.microchip.com
http://www.microchip.com
http://www.microchip.com/promo/curiosity-development-boards
http://www.microchip.com/mplab/mplab-x-ide
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

� Distributor or Representative

� Local Sales Office

� Field Application Engineer (FAE)

� Technical Support

Customers should contact their distributor, representative or field application engineer 

(FAE) for support. Local sales offices are also available to help customers.

Technical support is available through the website at: 

www.microchip.com/support.

REVISION HISTORY

Revision D (March 2020)

Added new layout revision and content updates.

Revision C (September 2019)

Updated Figures 2-1 through 2-4 and A-1.

Remove EU Declaration of Conformity.

Revision B (April 2016)

Added the EU Declaration of Conformity.

Revision A (July 2015)

Initial release of this document.

http://www.microchip.com/support/hottopics.aspx
http://www.microchip.com/support/hottopics.aspx
http://www.microchip.com/support/hottopics.aspx
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Chapter 1.  Introduction to Curiosity Low Pin Count (LPC) 

The Curiosity Low Pin Count (LPC) Development Board supports Microchip�s 8-, 14- 

and 20-pin 8-bit PIC® MCUs. Dual-row expansion headers on either side of the socket 

offer flexibility of connectivity to all pins on the PIC MCUs. Programming/debugging is 

accomplished through the PICkit� On-Board (PKOB), eliminating the need for an 

external programming/debugging tool. This board provides flexibility for 

experimentation through an application header with a ground (GND) and supply 

voltage (VSS) connections. It is also a set of indication LEDs, mTouch® button and push 

button switches, and a variable potentiometer. Additionally, the Curiosity LPC Board 

integrates a MikroElektronika mikroBUS� socket, which can accommodate a variety 

of plug-in Click� Board modules that can be used for application development.

1.1 CURIOSITY LOW PIN COUNT (LPC) DEVELOPMENT BOARD KIT 
CONTENTS

The Curiosity Low Pin Count (LPC) Development Board kit contains the following: 

� Curiosity Low Pin Count (LPC) Development Board 

� Quick Start Guide

� PIC16F18446 MCU

FIGURE 1-1: CURIOSITY LOW PIN COUNT (LPC) DEVELOPMENT BOARD 

REV 2

mTouch®

Button

�
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FIGURE 1-2: CURIOSITY LOW PIN COUNT (LPC) DEVELOPMENT BOARD 

REV 4
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Chapter 2.  Getting Started

The Curiosity Low Pin Count (LPC) Development Board contains a PICkit On-Board 

(PKOB) which allows for both low-voltage programming and low-voltage in-circuit 

debugging for all supported devices. When used with the MPLAB IDE, in-circuit 

debugging allows the user to run, modify, and troubleshoot their custom software and 

hardware quickly, without the need for additional debugging tools.

2.1 PROGRAMMING THE CURIOSITY LOW PIN COUNT (LPC) DEVELOPMENT 
BOARD

Programming the Curiosity LPC Development Board can be accomplished through 

MPLAB X IDE (version 3.30 or higher for Rev 2 and version 5.20 or higher for Rev 4). 

2.1.1 Programming Using MPLAB® X IDE

1. Connect the Curiosity LPC Board to the computer using the on-board micro-USB 

connector.

2. Open MPLAB X IDE and either create a new project or open an existing one.

3. Click on the Project Properties icon located in the project�s Dashboard window 

(as seen in Figure 2-1). Alternatively, the Project Properties window can be 

opened by clicking on File > Project Properties, or by right clicking on the project 

name in the Projects window and clicking Properties.

Note: The Curiosity LPC Board must be programmed using Low-Voltage 

Programming (LVP). The LVP bit of the Configuration Word(s) must be set 

(LVP = ON or �1�).
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FIGURE 2-1: PROJECT PROPERTIES BUTTON

4. The Project Properties window will open. This window allows for the selection of 

the programming tool, compiler and PIC MCU. MPLAB X IDE refers to the 

Curiosity LPC Board as �Starter Kits� in the Hardware Tool selection window, as 

seen in Figure 2-2.

FIGURE 2-2: SELECTING THE CURIOSITY LPC DEVELOPMENT BOARD 

5. In the upper left-hand corner of the Project Properties window, click on Starter 

Kits (PKOB). The window will now show the configuration options for the PKOB 

programmer, as shown in Figure 2-3.



 2015-2020 Microchip Technology Inc. DS40001804D-page 12

FIGURE 2-3: PROGRAM OPTIONS FOR THE PICkit� ON-BOARD (PKOB)

6. In the Option categories drop-down menu, select Program Options; ensure that 

the Low Voltage Programming mode is selected for Programming mode entry 

(Figure 2-4). The Curiosity LPC Board is now ready to be programmed.

FIGURE 2-4: ENSURE LOW-VOLTAGE PROGRAMMING IS ENABLED
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7. Once the project is ready to be programmed, simply click on the Make and 

Program Device button, and MPLAB X IDE will build and compile the code and 

program the PIC device, as displayed in Figure 2-5.

FIGURE 2-5: DEVICE PROGRAMMING



 2015-2020 Microchip Technology Inc. DS40001804D-page 14

CURIOSITY LOW PIN COUNT DEVELOPMENT

BOARD USER�S GUIDE

Chapter 3.  Troubleshooting

This chapter discusses common operational issues and methods to resolve them.

3.1 THE MCU WILL NOT PROGRAM USING THE PKOB

The Curiosity LPC Development Board�s PICkit On-Board (PKOB) uses low-voltage 

programming. Both MPLAB X IDE and MPLAB Xpress set the Low-Voltage 

Programming (LVP) bit to a �1�, allowing low-voltage programming. 

1. When using custom firmware, the LVP bit must be set to �1� in the Configuration 

Word. MPLAB X IDE will not allow programming using the PKOB unless the bit 

is properly configured.

2. When using a PIC microcontroller (one not included with the Curiosity 

Development Board) that has already been programmed using high-voltage 

programming and the LVP bit is cleared (LVP = OFF or �0�), the device will not be 

recognized and cannot be programmed using the PKOB. Reprogramming the 

device can be achieved by one of the following two methods:

a) Connect a PICkit� 3 Programmer to the PIC device dual-row expansion 

headers, ensuring the appropriate ICSP�, GND, and VDD connections are 

made. Configure MPLAB IDE to use the PICkit 3 as the programmer, and 

ensure the LVP bit is set to �1� in the Configuration Word. Reprogram the 

device.

b) Use an unprogrammed (blank) device and ensure the LVP bit is set to �1� in 

the Configuration Word.

3.2 THE MPLAB PICKIT� 4 ON-BOARD (PKOB4) DOES NOT PERFORM

Use the Hardware Tool Emergency Boot Firmware Recovery Utility to restore hard-

ware tool boot firmware to its factory state. The recovery utility window can be opened 

by clicking on Debug > Hardware Tool Emergency Boot Firmware Recovery Utility in 

MPLAB X IDE.The Curiosity LPC Development Board�s PICkit On-Board (PKOB) uses 

low-voltage programming. Both MPLAB X IDE and MPLAB Xpress sets the Low-Volt-

age Programming (LVP) bit to a �1�, allowing low-voltage programming. 
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Appendix A. Schematic

A.1 CURIOSITY LPC DEVELOPMENT BOARD SCHEMATICS

FIGURE A-1: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 2 (1 OF 1)
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FIGURE A-2: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 4 (1 OF 4)
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FIGURE A-3: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 4 (2 OF 4)
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FIGURE A-4: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 4 (3 OF 4)
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FIGURE A-5: CURIOSITY LPC DEVELOPMENT BOARD SCHEMATIC REV 4 (4 OF 4)
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CURIOSITY LOW PIN COUNT DEVELOPMENT

BOARD USER�S GUIDE

Appendix B. General Notes

B.1 mikroBUS� CLICKS

Module 1 is the main click socket, and Module 2 is the secondary socket. Both sockets 

are fully compatible with a 40-pin PIC device; however, when using 28-pin devices, not 

all pins are available. 

All pins in Module 1 are available for use with the exception of the mikroBUS's Reset 

(RST) signal, which is tied to pin RD0. PORT D is not available on 28-pin devices. If 

the RST signal is needed, remove the solder blob jumper associated with the 

mikroBUS RST connection, and place a jumper wire between the via next to the solder 

blob jumper and the desired pin connection found in the J8 or J11 dual-row expansion 

headers (see Figure 1-1).

All pins in Module 2 are available for use with the exception of the mikroBUS's Reset 

(RST) signal (RD2), SPI Chip Select (CS) signal (RD3), and the PWM (RD1) signal. 

These signals are routed to the PORT D pins, which are not available on 28-pin PIC 

devices. If these signals are needed, remove the solder blob jumpers associated with 

the mikroBUS connection pins, and place jumper wires from the vias located next to 

the associated solder blob jumpers to the desired pin connections found in the J8 or 

J11 dual-row expansion headers (see Figure 1-1).

B.2 SOLDER BLOB JUMPER

Solder blob jumpers can be found on each Click module, push-button switch, LED, or 

potentiometer connection. This allows the user to utilize those pin connections for other 

applications.
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